Chapter 5
Devices

A “device” is the name HCA gives to real world items – like a switch or module – that it can control.

First you “create” the device in HCA using the New Device Wizard. When you create the device in HCA, you give it a name, and other parameters. The New Device Wizard helps you through this process for each device that you want to create for your own home. Then if you need to, you can later modify the properties that you set up when you created each device.

This chapter concentrates on creating devices and how to later modify the properties for any device. Sections in this chapter include:

- About devices
- Planning your devices
- Creating a new device
- Modifying an existing device
  - Using the Options tab
- Deleting a device
- Insteon devices
- UPB devices

About devices

“Device” is the term used in HCA to represent any item in your home that is controlled with power line signals - Insteon, UPB, X10, IR. A device can be a lamp or appliance, in any room or location of your house. Each device has some way to identify it from all others. For X10 devices this is by a house code and a unit code which is set some way at the switch or module. For UPB devices this is the unit code assigned to it when it was set up. For Insteon this is the address that is assigned when it is manufactured. HCA must know the device’s address so that HCA can control it.

In HCA, a device can be independent, it can be part of a group, it can be controlled by a schedule and programs. You may want to review the chapters on groups, schedules, and programs before you begin to create devices, as how it is controlled may affect how you name it, or what notes you want to include with the device. You will also want to read the following section on planning your devices before you get down to the creation of the devices.

UPB devices are added to your design by importing a UPB network file. This is explained in the UPB appendix.

How IR devices are set up and controlled depends upon the IR interface being used. See the IR appendix for the Global Cache and Bitwise which are interfaces for controlling IR devices.

Planning your devices

Before you start creating devices in HCA, it’s a good idea to consider which devices you want to create, where they are, how they work, and how they might work together. When creating devices, there are two possible scenarios; either you already have controllable switches and modules in your home, or you don’t. The way you plan for creating HCA devices differs slightly, depending on how you start.
If you already have modules and switches in your home, you need to make a list. You can check each one and write down:

- the location
- the type of light or appliance it controls
- the manufacturer and model number
- The address if it has an user settable address

If you do not yet have controllable switches and modules in your home, it may be easier to create the devices in HCA, and then print out a list of what you plan to add. You can take this list with you and use it as you setup the modules and wire in the units in different parts of your home.

Creating a new device

Now, if you know which devices you want to create, and have made an installation plan, you’re ready to begin creating devices. There are three ways to start the New Device Wizard:

- Right click on the background of the display pane and select New – Device.
- Right click on a folder name in the design pane and select New – Device
- Press the New Device button in the ribbon Design category.

Any of these options opens the New Device Wizard.

Type in a name for the device and type in or choose one of the already existing rooms or folders to store this device. The device name must be unique in the chosen folder. The name you enter can contain most characters, and can be of almost any length.

To aid in recognition, you can name devices with descriptions, or location identifiers. For instance, you could name devices: Katie’s night light, dining room chandelier, or Bedroom Lamp 1, 2, and 3.
Click Next and add any notes you might want to remember about this device. The notes can tell you where the device is (hidden in the attic), what it looks like, or what socket or circuit it is connected to. You can review, and revise or delete these notes later at any time. These notes can be displayed in a popup window when the mouse is moved over the icon for this device.

In the next step you specify what type of device being created. The choices you have depend upon the manufacturer you select. First select a manufacturer and then select the type of switch or module.

**Hint:** Don't be worried if you don't see exactly the product you have. Many times two parts will have different part number (for example a 600w or a 100w switch) but work the same way. If you don't see exactly what you want just pick something close. In most cases that will be fine.
Make your selections and then click Next.

The next step in the Wizard depends upon what type of device you are creating. For an Insteon device, in this step you chose how HCA determines the device address and type. For other device types the address entry may be done in other ways.

Now you get to choose the icon that you want to represent this device on a display. The listing includes all device icons provided in the default Icon Theme. See the chapter on Icon Themes for more information.
When you first get to this step, HCA tries to choose an icon based upon the name you supplied and the type of device. Sometimes it chooses well and other times not. Click the icon that you want to use, and click Finish as this is the last step in the wizard.

Modifying an existing device

Once a device is created, you can modify any of the properties that you set in the New Device Wizard. You do this in the Properties dialog for the particular device. There are two ways that you can get to the device properties:

1. Select either:
   - the device **icon** on a display or
   - the device **name** in the design pane
2. Click the right mouse button.
3. From the popup menu, select Properties.

The Properties dialog title reflects the name of the device you selected. The Name, Notes, Type, and Icon tabs have the same information as the corresponding Wizard steps.
4. Click the tab you want to change properties on, or click each to review the settings for this device. You can change whatever you like, and click OK to save your changes.

In addition to the tabs that are similar to the Wizard steps there are many others. Some of these are specific to the type of device and others always appear.

**Triggers Tab**

Each device has a single address that it responds to. For Insteon it is set at the factory. For UPB it is automatically selected when added to a UPB network. For X10 devices this is something you choose. But the common thing is that each device has exactly one address and this can be a problem.

You may have a situation where you would like to give a device multiple addresses. Perhaps even a different address on a different protocol. For example, to control an X10 device with a UPB keypad.

This is what the triggers tab is for. This can be a complex topic so an example with some simpler X10 devices may help make the concept clearer but the idea is the same with all protocols.

Suppose your home contains a device called “Den lamp” and is assigned an address of B1. Also imagine that you have a keypad someplace in your home set to housecode B. You can use this keypad to control this lamp.

But what about other keypads in your home? Perhaps you have a wireless keypad that you want to be able to take throughout the house and be able to control devices in various rooms. For that to work you would need to set the wireless receiver to some housecode and have all the devices you want to control set to the same housecode. This may be ok, but maybe not.

This is where triggers come in handy. Suppose that wireless keypad is set to housecode K and you want to use K3 to turn on and off the den lamp. If you add a trigger of K3 to the den lamp device then here is what happens.

1. You press the K3 On button on the wireless keypad. It is received by the wireless transceiver, put on the powerline and then received by HCA.
2. HCA finds that K3 is a trigger for the Den lamp so it sends an On command to B1.
3. The light comes on.

If you had sent a K3 Off command, HCA would have sent out B1 Off.
You can create any trigger you want – from any protocol – and if received by HCA it will determine the command associated with the reception – on, off, dim, bright, etc – and retransmit that to the device using the device’s address and the command – translated across protocols if necessary.

To remove a trigger for a device, right-click on the trigger and select Delete from the popup menu. To change a trigger for a device, right-click – or double-click – on the trigger and select Edit from the popup menu.

**Restart Tab**

On this tab you determine what happens to this device when HCA is started. You should carefully consider the selection for this step, in light of the device that you are creating.

- If you have an appliance that is best not left unattended (one that generates heat), the best choice is "Make sure the device is OFF".
- The device can be set to follow the schedule you have for the device,
- Only in very special circumstances should you ever choose Make sure the device is ON, and then only for devices like lights.

For some devices, like the X10 chime, you may want to have HCA send no commands.

**Display Tab**

While an icon for this device always appears in the display for the folder than contains it, you can, if you want, place an icon for it on other displays as well.

On this tab you can add an icon for the device onto one or more displays. Click the display where you want the icon to appear, click the right arrow →, and the display appears in the right list. You can move one, two, or all of your displays to the right column. If you find that you’ve listed a display in the right column mistakenly, you can select it, and click the left arrow ← to return it to the left column.
To move the icon to where you want it on the display, select it with the pointer, click the mouse, and drag it to its intended location. When you release the left mouse button, the icon is dropped at that location. If the Auto Arrange option is enabled, you will be limited in where you can drop the icon.

The other sections of this dialog are explained in the chapter on the Control User Interface.
Log Tab

The Log tab contains the log for this device. Normally a log entry is added whenever a reception from this device is received or HCA transmits to this device. You may not want to log some devices that generate a lot of traffic.

Transmissions and receptions for a device can create entries in the log used for the device’s protocol or to a specific log. Each interface can route log entries for the protocols it supports to one of the three logs. This is specified in the interface configuration options in HCA Options.

Groups Tab

On this tab you can add this device to one or more groups. Groups are more fully covered in their own chapter but, in general, a Group is a set of devices that HCA controls as a unit. If you have a group with three devices, then you can control that group with a program or schedule and all three devices are affected.

You can add devices to groups using the properties for the group but you can also add or subtract devices from groups using this tab.
Schedule Tab

HCA contains many different scheduling tools and these are covered in later chapters. In addition to those tools, you can add or remove a schedule entry for a device using this tab. To add a new schedule entry for this device to a schedule, double-click on the “Add new” branch below the schedule. You can add a schedule entry that makes this device go on, go off, or go on then off at a later time.

To remove a schedule entry for a device, right-click on the schedule entry and select Delete from the popup menu.

To change a schedule entry for a device, right-click – or double-click – on the schedule entry and select Edit from the popup menu.

Poll Tab

For devices that support status requests, the Poll tab is where you can specify if HCA should periodically request status from the device and how often to do that. In many cases this isn’t necessary as many devices reports their status when controlled.
Transmission Tab

When communicating with a device problems could happen. The command could be sent but interfered with by noise or the command could collide with other commands being sent by other transmitters.

HCA provides two options that direct it to check for proper receipt and process of the command. Some communication protocols have the device acknowledge if the command is received by the device. Also some devices support requesting status from the device. Both of these can be used to verify that the command was received and processed.

The two forms of confirmation are enabled by the checkboxes on this tab of device properties.

- Request and look for an acknowledgement form a device. Not all protocols support this and those that do don’t offer it in all contexts. UPB, Insteon, and Hue lights do offer this. However if you are using UPB devices and your installation has a repeater then the ACK method is unavailable.

- After sending the device a command, send an additional command to request the status of the device to see if it is at the level the original command was trying to achieve. Not all devices have a status request feature.

Both confirmation methods attempt to retry the command if it can’t be confirmed. If after several attempts the icon for the device will be marked in a way to show that communication with it has failed.

**Note:** It is important to understand that these confirmation methods can’t be used in all cases. For example, if UPB device is commanded to go to 50% over 10 minutes then a status request during those 10 minutes will not show 50% but the current level of the device as it goes – slowly in this example – to 50%.

**Also Note:** Don’t overuse this feature as it can make a system less reliable as the status request commands can collide with other commands and the result is that both commands are lost.
Here is an example. There is a device icon showing ON. You tap on it. It immediately changes its representation to show ON. This confirms that you did indeed tap on it. The command is sent out. If one or both command confirmation options are enabled, HCA in the background will confirm receipt of the command. If that happens then nothing changes on the display. If the command confirmation fails then the icon label text changes to show the error.

**A note about scenes**

A scene command – in any protocol – can by its nature update more than one device. HCA makes no attempt when activating or deactivating scenes to confirm receipt of the command by each scene members. When using the UI and right-clicking on a device, those scenes that the device responds are listed in the popup menu. But when the command is sent, it is sent as a scene command and not a command to that single device. Again, even though you right-click on a specific device if you choose a scene name that scene is activated for all devices that participate in that scene and not just the device right-clicked upon.

**References Tab**

The references tab brings together into one place a report on the use of this device in your design. Devices can be used in many places: schedules, programs, groups, protocol bridges, etc.

This provides a quick way to tell where this device is used in case your design becomes complex.
Green Tab

The Green Tab is where a device is configured in its respond to what the current home mode is. This topic is full cover in the *Home Modes* chapter.
Protocol specific tabs

Depending upon what protocol the device supports you may see additional tabs. These tabs configure or examine options specific to that protocol. For example for Insteon devices you will see an Insteon tab, for UPB devices a UPB tab.

For example, for this Insteon device, the Insteon tab shows the address and the linking table.

For a UPB device:

For older style X10 devices there are lots of configurations options since each device type may operate differently from different manufacturers.
Deleting a device

If you find that you have created an incorrect device, or if you get rid of an existing appliance, you have two options.

- You can modify the properties for the device. For instance, changing the name and notes (but retaining the house and unit codes) of a lamp that has been replaced with a newer model, or changing the location and address (house and unit codes) of a lamp that you’ve moved.
- You can delete the entire device.

To delete a device:

1. Use the right mouse button to click the device name in the design pane of HCA.
2. Click Delete.

   HCA removes the device name from the design pane, and removes the icon from any displays it appears on.

**Warning:** Be sure to check all aspects of a device before you delete it. If you delete a device, it is gone, any group it was a part of still works, and any schedule it was listed in is still valid, **but** any program it was a part of will not start.

**Hint:** However, you can use the Undo command on the Edit menu to restore the deleted device. It will undo just the last change you have made—so if you delete the device for a toaster and then a lamp, you can undo deleting the lamp, but not the toaster.
Insteon Devices

Once an Insteon device has been added to your design, when you open its properties dialog Insteon devices have a **Linking** tab.

This tab is fully described in the Insteon appendix.
UPB Devices

UPB Devices are not added to your design using the New Device Wizard. They are imported from a UPB Network definition file.

Once added, they do have properties like all other devices. On the UPB Id tab is the information about the UPB device as read from its setup memory.

The Options tab for UPB devices is described in the UPB Appendix
Final device topics

There are two additional topics to discuss with devices.

Icon placement

As part of the device properties dialog you can select one or more displays to show an icon for the device. If you are using a display with a DXF or picture background you may want to show more than one icon for the device on the display. Perhaps this will make a more realistic appearing floor plan.

To place more than one icon for a device on a display, right-click on the single icon placed by the wizard and select Icon and Add from the menu. At this point you can select the icon picture to use. An additional icon for the device is created and placed on the display. You can then drag it to whatever place you want.

To remove an icon, right-click on the icon and select Icon and Remove from the menu. The icon is removed from the display.

To change the picture of the icon, right-click on the icon and select Icon and Change from the menu.

Retrieving the status of a device

If a device supports status reporting you can have HCA request its status by using the right mouse button to click the device name in the design pane or on an icon in the display pane and select Get Status.

Locally Stored Scenes

If the device supports scenes (illumination level and in some cases the rate at with the light changes up or down to that level), any scenes that you have identified to HCA are listed in the popup menu. If you select one of those scene names, the command to set the switch to that scene is sent.

HCA contains features from programming scenes in some device types. For example, Insteon device scenes can be created by using the Visual Scene Editor. This is described in the Insteon appendix.